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Adobe InDesign CS.
Pārnesumu veidošana latviskiem tekstiem izmantojot 
Tildes Biroja iebūvēto pārnesumu veidošanas iespējas.

Ievads
Lielākajai daļai maketētāju, strādājot ar tekstiem zobusāpes ir sagādājuši teksti, kas jānolīdzina pēc abām ma-
lām (Justified). Problēmas raksturs ir vienkāršs – lai teksts izskatītos labi, ir nepieciešams izvietot pārnesumus, 
bet, lai to izdarītu, lielākā daļa vēl joprojām izmanto vissenāko metodi – izvieto šos pārnesumus manuāli, t.i. 
– izskata visu tekstu un saliek pārnesumus vietās, kur tas ir nepieciešams.
Ja teksta nav daudz, tad tas nesagādā lielas problēmas, bet tiklīdz teksta ir ļoti daudz, piemēram, žurnālu, 
avīžu maketi, tad parādās problēma tai brīdī, kad makets pirmo reizi ir uztaisīts un pēc tam nodots korekciju 
veikšanai. Ja teksts kaut kur maina lauzumu, piemēram, tiek izņemta kāda rindkopa vai atsevišķs vārds, tad 
pēc tam pārnesumi ir jāliek no jauna. Tas var kļūt par patiešām lielu problēmu.
Šajā pamācībā izskatīsim vairākas kombinācijas darbam ar pārnesumiem. Pamatā uzsvars tiek likts uz Adobe 
InDesign CS un InDesign CS2, bet, tā kā autors vēl joprojām uzskata, ka Adobe tā sauktās biznesa klases pro-
dukts Adobe PageMaker ir lielisks rīks grafiski vienkāršu maketu veidošanā, atsevišķi tiks sniegts ieskats arī 
darbā ar šo programmu un latviešu tekstiem.
Visi piemēri ir veidoti un darbojas uz Windows XP operētājsistēmas (jo autors uzskata, ka Windows 
95/98/2000 sistēmas ir morāli novecojušas).
Paralēli darbā un InDesign CS vajadzēs arī Tildes Biroja programmu Tildes Rakstvedis vai arī Microsoft Office  
programmas Microsoft Word papildinājumu no Tildes Biroja, kas saucās Zilbjdale (Put optional hypen signs) 
un darbojas kā makrokomandas spraudnis. 
InDesign CS2 jau ir iebūvētā latviešu valodas bibliotēka (ar noteikumu, ka ir uzstādīti visi pēdējie program-
mas atjauninājumi), tāpēc tai darbā ar latviešu tekstiem nav nepieciešamas ārējās programmas.

Sagatavojamies darbam
Tātad, lai varētu veiksmīgi izprast visu turpmāk aprakstīto, vislabāk būtu, ja tiktu sagatavots kāds teksts (ap-
tuveni 10 000 zīmes) latviešu valodā, bet ne zinātniska rakstura. Autors izvēlējās tekstu, kas ir publikācija 
presē, jo tādos tekstos parasti ir dažāda valoda un tāpēc var vispusīgi apskatīties uz tekstu un pārnesumu 
darbību.
Papildus cerams, ka darbastacija jau ir sagatavota darbam un tai ir uzstādītas visas nepieciešamās programmas 
(atkarībā no tā, ar kurām no visām jūs strādājat):
1) Adobe InDesign CS (papildus nepieciešams MS Word un Tildes Birojs)
2) Adobe InDesign CS2
3) Microsoft Word
4) Tildes Birojs (2000, 2002, 2005 gadu versijas)
Visām programmām ir jābūt uzstādītiem pēdējiem atjauninājumiem, kurus iespējams iegūt programmu iz-
strādātāju mājaslapās (www.adobe.com, www.tilde.lv). Šī prasība ir saistīta ar to, ka programmu sākotnējās 
versijas satur daudz kļūdu, bet viens no Adobe InDesign CS2 atjauninājumiem satur latviešu valodas biblio-
tēku.
Paralēli darbastacijas Windows XP ir jābūt uzstādītam pēc noklusējuma angļu tekstu kodu tabulām. To var 
pārbaudīt: Control Panel -> Regional and Language Settings -> Advanced. Tur ir jābūt izvēlētam, English 
(United States). Ja tas nav izdarīts, tad pēc izmaiņu veikšanas nāksies pārstartēt datoru. Tāda kodu tabulu 
izvēle ir saistīta ar operētājsistēmas Windows problēmām ar kodu tabulām, kas vēl joprojām nav atrisinātas 
un cerams, ka kaut kas būs mainījies ar Windows Vista iznākšanu, tātad šīs izmaiņas nav jāsaprot kā labus 
uzstādījumus, bet drīzāk kā noteikumu apiešanu, lai vispār kaut kas strādātu.
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1. attēls. Ar Adobe InDesign CS, Microsoft Word 2000 un Tildes Biroja spraudni priekš MS Word pārnesumu veidošanai sagatav-
ots latviešu valodā sarakstīta teksta makets, kurā uzskatāmi var redzēt, kā izskatās labi sagatavoti pārnesumi un tai pat laikā 
redzamas arī problēmas, kas saistītas ar pārnesumu veidošanu.

40 000 ie­prie­k­špārdo­ša­nā iz­tirgo­to­

biļe­šu, no­ k­urām 5 000 – uz­ Je­l­

ga­va­s k­o­nce­rtu, be­t Jānis Juba­lts 

pa­rū­pē­šo­tie­s pa­r la­bu la­ik­u. Tāda­s

ir La­tvija­s je­lk­a­d lie­lāk­ās muz­ik­ālās 

a­pvie­nī­ba­s «Prāta­ vē­tra­» vē­sma­s

pa­r sa­vām ie­ce­rē­m. «Biļe­šu pārdo­ša­­

na­s re­z­ultāti lie­cina­, k­a­ tū­re­ «Če­tri 

k­ra­sti» va­rē­tu bū­t a­pjo­mī­gāk­ā k­āda­s

grupa­s tū­re­ La­tvijā,» no­rādī­ja­ «prāt­

nie­k­u» me­ne­dže­re­ Aija­ Grimz­e­.

Tū­ri orga­nizē koncert­a­ģent­ū­ra­
«FBI» un «Bra­inSt­orm Records». 
Sā­kot­ a­r Cēsīm un beidzot­ a­r Rīgu, 
«Prā­t­a­ vēt­ra­» izbra­ukā­s visa­s La­t­vi­
ja­s nova­du cent­rus, t­ā­dā­ veidā­ piedā­­
vā­jot­ a­pska­t­īt­ies uzst­ā­ša­nos visiem 
int­eresent­iem.
Pirma­is koncert­s sā­ksies ja­u šova­ka­r
Cēsīs un šis bū­s vienīga­is grupa­s kon­
cert­s Vidzemē. Ša­jā­ pil­sēt­ā­ grupa­ ja­u
ir uzst­ā­jusies va­irā­kkā­rt­ un kā­ a­t­zīmē­
ja­ «FBI» va­dīt­ā­js Mā­rcis Gul­bis: «Ir 
pa­t­iess prieks pa­r Cēsu pil­sēt­a­s a­t­su­
a­cību. (..) Mums ir izveidojusies veik­
smīga­ sa­da­rbība­ a­r Cēsu pil­sēt­u un 
t­ā­pēc t­urneja­s a­t­kl­ā­ša­na­ un ģenerā­l­­
mēģinā­jumi not­iks Cēsu st­a­dionā­». 
Jā­a­t­zīmē, ka­ t­ieši pirms koncert­a­ Cē­
sīs, preses konferences l­a­ikā­ «Prā­t­a­
vēt­ra­i» t­iks pa­sniegt­s zel­t­a­ disks pa­r
rekordā­t­rumos pā­rdot­ā­ «Čet­ru kra­s­
t­u» diska­ 8 000 kopijā­m.

Jel­ga­va­ – sa­tu­ries!
Pa­gā­jušā­s t­ū­res «Dienā­s, ka­d l­id­
l­a­uks pā­rā­k t­ā­l­s» iet­va­ros spēcīgā­s
vēt­ra­s un l­iet­us dēļ koncert­s Jel­ga­vā­
t­ika­ a­t­cel­t­s. Šoreiz, sest­diena­s va­ka­rā­,
Renā­ra­ Ka­upera­ vā­rdiem t­icot­, Jā­nis 
Juba­l­t­s ir norīkot­s pa­r ofi­ciā­l­o «mā­ko­
ņu st­ū­mēju»: «Mēs esa­m uzdevuši nu 
ja­u no mū­su grupa­s vienīga­ja­m jel­ga­v­
nieka­m Jā­nim Juba­l­t­a­m pa­rū­pēt­ies, 
l­a­i šoreiz pā­r Jel­ga­vu mū­su koncert­a­
l­a­ikā­ bū­t­u ska­idra­s debesis. Kā­ viņš t­o
izda­rīs, t­a­s l­a­i pa­l­iek nosl­ēpums!».
Bez Juba­l­t­a­ ja­uno pienā­kumu dekl­a­­

rēša­na­s, kā­ informēja­
grupa­s pā­rst­ā­ve Guna­
Zučika­, orga­niza­t­oris­
ku iemesl­u dēļ  Jel­ga­vā­
koncert­s ir pā­rcel­t­s no 
st­a­diona­ «Da­uga­va­» uz 
Liel­upes pļa­vu pret­im Jel­­
ga­va­s pil­ij. Tā­ kā­ «prā­t­­
nieki» bū­s pa­rū­pējušies 
ne vien pa­r pil­sēt­nieku 
iepriecinā­ša­nu a­r sen ne­
redzēt­u brīvda­ba­s kon­
cert­u, bet­ a­rī visma­z uz 
vienu va­ka­ru a­t­dzīvinā­s
l­eģendā­ro muzikā­l­o pa­­
sā­kumu norises viet­u. 
Tū­res l­īdzorga­niza­t­oru 
«FBI» pā­rst­ā­vis Kris­
t­a­ps Kā­rkl­iņš pa­vēst­īja­,
ka­ «pa­sā­kuma­ norises 
dienā­, 6. a­ugust­ā­, t­iks 
sl­ēgt­a­ Pil­ssa­l­a­s iel­a­ pos­
mā­ no Jel­ga­va­s pil­s l­īdz 
LLU a­ut­ost­ā­vviet­a­i (ie­
ska­it­ot­).
Ceļš bū­s sl­ēgt­s ga­n a­ut­o­
t­ra­nsport­a­m, ga­n gā­jējiem». Bet­ ir a­rī 
pa­r ko priecā­t­ies – īpa­ši pa­domā­jot­
pa­r nejel­ga­vniekiem (beidzot­!!!), t­iks 
norīkot­s speciā­l­s vil­ciens Jel­ga­va­ – Rī­
ga­, ka­s a­t­ies pul­kst­en 00:35 no Jel­ga­­
va­s st­a­cija­s.

Teh­niski. Iespa­dī­gi.
Tā­ pa­t­, kā­ bija­ iepriekšējā­ grupa­s
«open­a­ir» t­ū­re, a­rī šoreiz ir īpa­ši pa­­
domā­t­s pa­r scenogrā­fi­ju. Grupa­s me­
nedžere Aija­ Grimze pa­st­ā­st­īja­: «Ja­
iepriekšējā­ t­ū­rē izma­nt­ojā­m La­t­vijā­
pieeja­mo t­eh­nisko a­prīkojumu, t­o pie­
mērojot­ sa­vā­m va­ja­dzībā­m, t­a­d šoreiz 
konst­rukciju un dekorā­ciju l­iel­ā­kā­ da­ļa­
t­iks izga­t­a­vot­a­ īpa­ši ša­i t­ū­rei. Kinēt­is­
ki ga­isma­s objekt­i, speciā­l­a­s ska­t­uves 
konst­rukcija­s, a­izska­ru sist­ēma­s – kon­
cert­u scenogrā­fi­ja­ ir dā­rga­ un sa­režģī­
t­a­, bet­ – mēs t­ū­ri vienmēr uzt­vera­m kā­
iza­icinā­jumu un priecā­ja­mies piedā­vā­t­
ska­t­īt­ā­jiem un pa­ši sev ja­una­s un kva­l­i­
t­a­t­īvi rea­l­izēt­a­s ideja­s. Pl­ā­not­s, ka­ La­t­­
vija­s koncert­os redza­mie el­ement­i t­iks 
izma­nt­ot­i a­rī uzst­ā­ša­nā­s reizēs ā­rpus 
La­t­vija­s, ka­s ir pa­redzēt­a­s pēc a­l­buma­
iznā­kša­na­s st­a­rpt­a­ut­iska­jā­ t­irgū­ rude­
nī». Jā­a­t­zīmē, ka­ scenogrā­fi­ju un reži­
ju koncert­iem izdomā­ja­ grupa­s bundzi­
nieks Ka­spa­rs Roga­ (kura­m ša­i t­ū­rē ir 
pa­redzēt­i vesel­i divi bungu kompl­ekt­i
uzst­ā­ša­nā­s l­a­ikā­), bet­ l­a­i t­o visu sa­l­ik­

t­u kopā­, t­ū­rei bija­ nepie­
cieša­ms pa­redzēt­ diva­s
ska­t­uves. 
Pirmā­ ja­u t­a­ga­d ir sa­t­a­­
pusi Cēsīs, bet­ ot­ro ja­u
no rīt­a­ mont­ē Jel­ga­vā­,
l­a­i l­īdz sest­diena­s va­ka­­
ra­m visu pa­beigt­u. 
Ska­t­uve t­iks a­prīkot­a­
a­r īpa­šā­m dekorā­cijā­m, 
kuru izga­t­a­voša­nā­ iz­
ma­nt­ot­i 80m dzel­zs 
konst­rukciju, 140 met­­
ru fi­niera­, 350 m2 a­udu­
ma­ un 150m2 st­ikl­a­,
sa­vukā­rt­ izma­nt­ot­o ne­
sošo konst­rukciju kop­
ga­rums bū­s 400 met­ru.
Pa­pil­dus šova­ el­emet­s
bū­s 25m2 videosiena­,
bet­ pa­r videopiemiņa­s
viedoša­nu rū­pēsies ko­
ma­nda­, kura­ va­dīs 5 
videoka­meru da­rbu no 
speciā­l­a­s pā­rviet­oja­mā­s
t­el­evīzija­s st­a­cija­s.

Visā La­tvija­
Pirmo reizi sa­va­s t­ū­res iet­va­ros 7.a­ugus­
t­ā­ «Prā­t­a­ Vēt­ra­» koncert­u sniegs Kul­­
dīgā­. Aija­ Grimze st­ā­st­a­, ka­ Kul­dīga­
izvēl­ēt­a­ domā­jot­ pa­r Sa­l­dus, Liepā­ja­s, 
Tukuma­ un Ta­l­su iedzīvot­ā­jiem, ku­
rus priecā­sies redzēt­ Kul­dīgā­. Jēka­bpil­ī
grupa­ uzst­ā­sies 13. a­ugust­ā­, Krust­pil­s
brīvda­ba­s est­rā­dē. Jēka­bpil­s koncert­a­m
ir īpa­ša­ vēst­ure, jo t­a­s pl­ā­not­s ja­u va­irā­­
kus ga­dus un šoga­d beidzot­ rea­l­izēt­s, 
pa­t­eicot­ies veiksmīga­i Jēka­bpil­s domes 
kul­t­ū­ra­s noda­ļa­s un grupa­s sa­da­rbība­i. 
Vent­spil­ī koncert­s not­iks 19.a­ugust­ā­. Šo­
ga­d pa­r koncert­a­ viet­u ir izvēl­ēt­s Reņķa­
dā­rzs. Ka­spa­rs Roga­: «Tū­res scenogrā­fi­­
ja­, ga­ismu režija­ un video ma­t­eriā­l­s, ko 
ga­t­a­voja­m ja­u il­gā­ku l­a­iku, ma­nuprā­t­,
izska­t­īt­ies īpa­ši efekt­īvi brīvda­ba­s est­rā­­
dēs». Tū­res nosl­ēgums pl­ā­not­s Rīgā­,
21.a­ugust­ā­. Visu «Prā­t­a­ vēt­ra­s» t­ū­ri 
pa­va­dīs a­rī īpa­šie viesi. Cēsīs un Jēka­b­
pil­ī t­ie bū­s «Mofo», Jel­ga­vā­ un Vent­s­
pil­ī ­ «Doubl­e Fa­ced Eel­s», bet­ Kul­dī­
gā­ – viet­ējie «The Munda­ne».
At­l­iek vien piebil­st­ nesen dzirdēt­o un 
a­t­va­inot­ies TVNET koment­ā­rus ra­k­
st­oša­jiem l­iepā­jniekiem, jo ja­ Liepā­ja­ ir 
pil­sēt­a­, kurā­ piedzimst­ vējš, t­a­d Jel­ga­va­
ir pil­sēt­a­, kurā­ piedzima­ Vēt­ra­ un t­a­ga­d
šī Vēt­ra­ ir ga­t­a­va­ a­ugst­a­ l­a­ikā­ pā­rskriet­
pā­ri visa­i La­t­vija­i!

Vēt­ra pārskrien Lat­viju
Fakt­i
◙ Iz­man­to­to­ gais­mu ie­kār­tu 
s­kaits­ pār­s­n­ie­gs­ 200
◙ gais­mu ko­mutācijas­ tiks­ 
ve­iktas­ ar­ 3km pagar­in­ātājvadu 
un­ kilo­me­tr­u in­fo­r­mācijas­ vadu 
palī­dz­ī­bu
◙ iz­man­to­tā e­le­ktr­ī­bas­ ko­pjauda 
būs­ 250kW
◙ pir­mo­ r­e­iz­i Latvijā tiks­ iz­man­to­­
tas­ 60 main­ī­gās­ lumin­is­cē­jo­šās­ 
gais­mas­ ie­kār­tas­ un­ 32 gais­mas­ 
dio­žu ie­kār­tas­
◙ ko­pē­jais­ gais­mu pie­kar­e­s­ 
s­var­s­ – 4 to­n­n­as­
◙ katr­ā ko­n­ce­r­ta PA s­kaņas­ s­is­tē­­
mas­ jauda s­as­n­ie­gs­ 70kW
◙ aps­kaņo­šan­ā tiks­ iz­man­to­­
tas­ 3 pultis­ un­ 3 «backlin­e­» 
ko­mple­kti
◙ s­katuve­s­ iz­mē­r­s­ – 350m2

◙ ko­n­ce­r­ttūr­e­s­ te­h­n­is­ko­ apr­ī­ko­ju­
mu apkalpo­ 150 cilvē­ku
◙ tūr­e­s­ uz­būve­ tiks­ tr­an­s­po­r­tē­ta 
ar­ 12 fur­go­n­ie­m
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Darbs ar Adobe InDesign CS
Atveram sagatavoto dokumentu ar Microsoft Word vai arī ar Tildes Rakstvedi. Sakarā ar to, ka Tildes Rakstve-
dim joprojām ir problēmas ar unicode tekstu tabulām, autors izvēlējās Microsoft Word. Iezīmējam visu tekstu 
un tad izvēlāmies Tools -> Put optional hypen signs (latviešu valodas versijai šis rīks saucas Pārnesumi). Pēc 
izvēlēšanās parādīsies logs, kāds redzams 2. attēlā.

Nospiežam OK un pagaidām, kamēr tiks salikti pārnesumi visā tekstā. Pārnesumu veidošanas tehnoloģija 
balstās uz algoritmu, kas izstrādāts Tildē. Algoritms tiek papildināts ar izņēmumu datubāzi, tomēr tā ir ļoti 
nepilnīga un tāpēc, kā redzēsim vēlāk, būs vēl jāpastrādā arī ar tādu tekstu, tomēr tas ir daudzreiz ērtāk, nekā 
pārnesumu likšana ar roku.

Neliela atkāpe. Kas tad īsti ir pārnesums elektroniskā izpratnē? Pārnesums ir simbols, kas 
vizuāli ir tieši tāds pats kā īsā defise, biežāk saukta par īso domuzīmi, kaut gan patiesībā 
defisei nav nekāda sakara ar domuzīmi. Atšķirībā no parastās defises, pārnesuma simbola 
decimālais kods ir 31 un tas ir speciāli rezervēts šai zīmei. Būtībā programmām, kas māk 
strādāt ar pārnesumu simbolu tiek paziņots, ka, ja tekstā parādās decimālais simbols 31, tad 
tas ir jāignorē izņemot gadījumus, ja tas atrodas vārdos, kas ir izvietoti blakus teksta bloka 
malai un var palīdzēt vienmērīgāk izlīdzināt tekstu, tad šis simbols sadala vārdu pa daļām 
un ir piesaistīts sadalītā vārda pirmajai daļai.

Pēc pārnesumu izvietošanas saglabājam tekstu un aizveram ciet dokumentu. Pēc tam atveram jaunu InDesign 
dokumentu un izmantojot File -> Place (CTRL+D), ievietojam tekstu dokumentā. Iepriekš tika sagatavots 
jauns dokuments, kas bija A4 lapa ar 20mm atkāpēm no visām malām un trīs kolonnām ar 5mm attālumu 
starp kolonnām. Tādējādi tiek iegūts aptuvenais teksta slejas platums, kas sastopams preses izdevumos.
Izlīdzinām tekstu pa trijām slejām un noformējam to, izvēloties kādu no serif fontiem, 8,5 – 10pt burtu lie-
lumu un nolīdzinām pēc abām malām.Piemēra gadījumā tika izvēlēts Garamond Premier Pro Caption, 10pt 
font size, 11,3pt leading, justify with last line aligned left.

2. attēls. Microsoft Word ekrāna paziņojums par pārnesumu izvietošanu tekstā.

3. attēls. Pamatteksta sleju salikuma izskats piemērā.
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Ja jums ir pagadījies šim darbam teksts ar kaut kādiem papildus elementiem – tabulām, grafikām, ielauzu-
miem vai apakšvirsrakstiem, nebaidieties un nemetiet tos ārā, bet gan pamēģiniet aplauzt un paskatīties, kā 
tas viss turas kopā. Tas vienmēr ir kā pozitīvs treniņš un citreiz, ja jums tagad izdosies atrast kādu interesantu 
salikumu, jau būs gatavi risinājumi maketu stiliem. 
Tagad izejiet cauri tekstam un apskatieties, kā ir izvietojušās pārnesuma zīmes. Citur tās būs jāizlabo – tas 
ir vienkārši izdarāms, iezīmējot pārnesuma simbolu un tad to izdzēšot. Citur būs kāds pārnesums jāieliek 
(piemēram, vārdos, kas ir pēdiņās vai arī ir rakstīti ar kapitāļiem). Lai ieliktu pārnesumu, vienkārši nospiediet 
taustiņu kombināciju CTRL+SHIFT+«-» (parastā defise).
Dažreiz tekstā gadās vārdi, kurus nevar pārnest vai arī tie pārnesoties tomēr veido lielas atstarpes starp vār-
diem. Tādos gadījumos vajadzētu lietot trekingu (Tracking – atstarpe starp burtiem). Nejauciet trekingu ar 
kerningu – kernings ir speciāls parametrs, kas raksturo atstarpes starp īpašiem burtu salikumiem, piemēram, 
«ff» «AT».
Trekinga parametri atrodas Character izvēlnē, bet klaviatūras saīsinājums ir ALT + bultiņa pa labi vai pa 
kreisi. Ieteicams lietot trekingu robežās no +40 līdz -40 parastam tekstam, jo tādus trekinga parametrus sa-
līdzinājumā ar pārējo tekstu pelēkais parastais lasītājs nepamana, bet lielāki trekinga parametri asi krīt acīs. 
Nav ieteicams lietot vai arī atstāt trekingu izmanītu, ja tas nav nepieciešams, jo, ja jūs lietojat profesionāli sa-
gatavotus fontus, tad tiem ir iebūvēti trekinga parametri atbilstoši tam, kādus ir izvēlējušies fonta veidotāji.
Paralēli pārliecinieties, ka jums nav uzstādīts automātiskais Hyphenation, kas ir atrodams InDesign zem Pa-
ragraph paletes papildus opcijām (apaļā bultiņa labajā augšējā stūrī Paragraph paletē) un tā arī saucas – Hyp-
henation. Pie ieslēgtas funkcionalitātes InDesign mēģinās automātiski ievietot pārnesumzīmes tekstā, kas nav 
iespējams ar InDesign CS versiju, jo tai nav iebūvēta latviešu valodas bibliotēka.
Tagad atliek tikai sagatavot pārējo dokumenta salikumu un jūsu latviskais teksts būs pabeigts.

Darbs ar pārnesusmiem Adobe PageMaker maketos
Līdzīgs princips ir arī darbā ar InDesign mazo brāli Adobe PageMaker, tikai jāatceras, ka PageMaker doku-
mentu ievietošanas filtrs ļauj ievietot tikai Microsoft Word tekstus, kas saglabāti vecajās versijās (līdz Microsoft 
Word 97), bet var no tā izvairīties, saglabājot tekstus *.rtf formātā. Arī PageMaker, līdzīgi kā Tildes Rakstve-
dim ir problēmas ar unicode, bet tās, visticamāk, lietotāji jau būs paguvuši atklāt un atrisināt.

Daudz vieglāk – Adobe InDesign CS2
Dažus mēnešus pēc Adobe izdeva savu Creative Suite otro versiju, parādījās papildinājums, kas it kā attiecas 
tikai uz Central European edition. Šajā InDesign papildinājumā ir izlabots lērums kļūdu, bet, kas pats patī-
kamākais, ir pievienotas praktiski visu Eiropas valodu bibliotēkas, kas ļauj pilnvērtīgāk strādāt ar tekstiem, 
neizmantojot ārējās programmas. Šis atjauninājums tikpat labi ir uzstādāms gan uz centrāleiropas InDesign 
versijas, gan arī uz parastās versijas bez centrāleiropas papildinājumiem darbam ar tekstiem.
Paņemam jaunu dokumentu un vienkārši ievietojam tajā kādu tekstu latviešu valodā. Autors izvēlējās A5 
formāta lapu ar 10mm atkāpēm no visām malām un 3 slejas ar 3mm atstarpi starp tām.
Pamattekstam izvēlēts Minion Pro 9pt lieli burti ar 10,3pt līnijstarpām. Pēc tam iezīmējam visu tekstu un no 
Character paletes Language izvēlenes izvēlamies Latvian. Tālāk paņemam zem Paragraph paletes no papildus 
opcijām Hyphenation un ieslēdzam to. Uzstādam parametrus, kādus var redzēt 4. attēlā un pēc tam vienkārši 
pielabojam atlikušo tekstu ar kerninga mainīšanu.

4. attēls. Autora izvēlētie Hyphenation paletes uzstadījumi.
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«Stīva Vaja ģitārspēles 
maģija ir tik iespaidīga, 
ka agrākos laikos viņš 
noteikti būtu sadedzināts 
kā burvis!», tā savulaik 
rakstījis žurnāls 
«Guitar World».

Stīvs Vajs (Steve Vai), kompo-
nists, ģitārists un dziedātājs, divu 
Grammy balvu ieguvējs, dzimis 
1960.gadā ASV, bērnībā mācījies 
ģitārspēli pie Džo Satriani (Joe 
Satriani) un jau divdesmit ga-
du vecumā pēc leģendārā Fren-

ka Zapas (Frank Zappa) aici-
nājuma uz vairākiem gadiem 
pievienojies viņa grupai gan 
koncertturnejās, gan albumu 
ierakstos, izpildot virtuozas ģi-
tāras un dažbrīd arī vokāla par-
tijas. Vēlāk viņš sadarbojies gan 
ar „Alcatrazz”, gan Deividu Lī Ro-
tu (David Lee Roth), gan „Whites-
nake”, gan „Alice Cooper”, līdz no-
devies spīdošai solokarjerai. 

Jaunais albums „Real Illusions: 
Reflections” ir pavisam svaigi sace-
rēts materiāls un, kā stāsta pats Vajs, 
tas ir „daudzslāņains mūzikls par atklā-
jumiem, kas sagaida patiesību meklējo-
šu trako reālajā pasaulē.”

Rīgā Stīvs Vajs ieradīsies 13.oktobrī pēc 
uzstāšanās Igaunijā un jau nākamajā die-
nā dosies uz Lietuvu.

Dzīvā leģenda

Stīvs Vajs 
uzstāsies
Latvijā

Grūti aprakstāmais ģēnijs
Četru «Grammy» balvu iegu-

vējs, Madonnas, Jay-Z, «Aerosmi-
th» un daudzu citu zvaigžņu atse-
višķu dziesmu autors 10. jūlijā Rīgā, 
«Skonto» viesosies amerikāņu mūzi-
kas leģenda Lenijs Kravics.

Latviju mūziķis apmeklēs savas 
pasaules tūres, kas aizsākās jau mar-
tā, «Baptism» ietvaros, tādējādi pre-
zentējot arī savu jauno albumu ar tā-
du pašu nosaukumu. 

Pēc vairākiem neveiksmīgiem 
mēģinājumiem vēl tīņa vecumā at-
darināt Prince, Lenijs, nepārprota-

mi ietekmējies no vecākiem un viņu 
draugiem (tādiem, kā Ella Fidžeralde 
un Mails Deivis), 1989. gadā pirmais 
viņa izdotais albums «Let Love Rule» 
uzsāka mūziķa pasaules karjeru.

Pēc albumu «Mama said», «Are 
You Gonna Go My Way?», «Circus», 
«5» un «Lenny» izdošanas, jaunajā 
albumā «Baptism» mūziķis it kā at-
griežas atpakaļ – izgājis caur funk, 
reggae, pop, rock un pat tehno 
un rap stilu kombinācijām, Lenijs 
nostaļģiski mēģina noslēgt šo apli, 
lai sagatavotos jaunā atsākšanai.

5. attēls. Ar Adobe InDesign CS2 sagatavots latviešu valodā sarakstīta teksta makets. Atšķirībā no InDesign CS 
versijas, InDesign CS2 ir daudz vieglāk strādāt ar tekstiem un nav nepieciešamas jebkādas ārējas program-
mas, kas veidotu pārnesumus vai kā citādi apstrādās tekstus pirms ievietošanas maketā. Vienkārši paņemam 
tekstu, ievietojam to paredzētajā vietā un uzstādot latviešu valodu pielabojam pārnesumu veidošanas 
uzstādījumus un tas arī viss - pārējo mūsu vietā izdarīs InDesign. Autors gan vienmēr iesaka tomēr pārskatīt 
tekstus, jo tieši tāpat kā Tildes Biroja, arī Adobes algoritmā ir daudz neprecizitātes un neatzīmētie izņēmumi, 
kas jāizlabo manuāli.
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Arī šajā gadījumā mēs varam manuāli uzstādīt pārnesumu zīmes, tikai tādā gadījumā InDesign ignorēs savus 
iebūvētos pārnesumu uzstādīšanas parametrus un vispār nelietos savus algoritmus attiecīgajam vārdam. Tas 
lieti noder gadījumos, kad InDesign pārnesumus saliek kā nevajag vai vārdam, kuru nevar dalīt, tad vienkārši 
ieliekam manuālo pārnesuma simbolu uzreiz aiz attiecīgā vārda un InDesign ignorēs šo vārdu un nelietos 
pārnesumu algoritmu attiecībā uz to. 5. attēlā var apskatīties tekstu lauzumu, kas sagatavots izmantojot 
InDesign CS2.

Dažas piezīmes
Lai nerastos problēmas, būtu vēlams iepriekš pārbaudīt, vai teksts, ko atverat ar Microsoft Word viss ir no-
definēts kā teksts latviešu valodā. To var izdarīt, iezīmējot visu tekstu un izvēloties Tools -> Language -> Set 
Language, kur jāizvēlās Latvian.

Citkārt problēmas, kā jau minēju, sagādā Tildes Rakstvedis. Tas vēl joprojām nav pilnīgi unicode formāta 
atbalstītājs un savā darbībā pamatojās uz sistēmas informāciju, bet, tā kā mums sistēma ir sagatavota darbam 
ar angļu kodu tabulām, programma bieži vien sabojā tekstu. To var atrisināt ar Tildes Konvertoru, bet tas ir 
ķēpīgs process, tāpēc pēc iespējas ietecams lietot Microsoft Word vai tā analogu Open Office, kurā Tildes Biroja 
pielikumi arī strādā.

Autoram tā arī nav izdevies, pat kontaktējoties ar Tildi noskaidrot, kā var atrisināt problēmas ir ar burtiem 
«š» un «ž», kas parādās, strādājot ar tekstiem un pēc tam tos sagatavojot drukai. Problēma slēpjas tajā, ka 
šie divi burti neizprotamu iemeslu dēļ unicode ir definēti divās vietās, tāpēc maketos bieži vien nākas tos vien-
kārši manuāli pārrakstīt pēc ievietošanas. Problēma ir saistīta tikai un vienīgi ar Microsoft Office versijām sākot 
ar 2000, bet cieši saistītas ar Tildes Biroju. Ieteikums, kas palīdz atrisināt šīs problēmas aizmiršanu ir vienkārša 
skripta izveide InDesign, kas aizvieto nepareizos simbolus ar pareizajiem.

Nekad nevajag pārspīlēt ar pārāk blīvu vai arī pārāk izstieptu tekstu manuālu mocīšanu, jo, visticamāk, to tik 
un tā neviens nepamanīs. Retinājumus vai sablīvējumus labojiet tikai kritiskajās vietās. Tas ieekonomēs jums 
gan nervu šūnas, gan arī laiku.

Paraugmaketu veidošanā ir izmantoti Kultūras portāla SV.LV teksti un fotogrāfijas kā arī autora ilustrācija.


